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PRESIDENT’S CORNER

Seasons Greetings Everyone!
I’m going to jump right into the meeting topics.

December 8th Meeting – Holiday Party!

Upgrading and repairing your computer…
Some people may have bought some
goodies for their PC over the recent Black Friday
sales. If you have some specific questions or need
some special help, bring your system into the
school, we can attempt to correct the issue.
This is also the Holiday Party! Bring your
favorite Holiday treats to share with the other
members of the group.

January 12th Meeting – Voice Recognition
Using Windows 7
One of the little known features of
Windows 7 is the ability to use voice recognition

in many applications. At the January 12th meeting,
we will demonstrate this feature.

February 9th Meeting – Service Pack 1 for
Windows 7

There was a delay in the release of the first
Windows 7 service pack. This probably means
some new features were added to the Service Pack
and we will review some of the more interesting
aspects of the update.

Meeting Topics

We will have more topics as time goes on.
Your input as to what you would like to see
demonstrated at the meetings is welcome. Please
let us know.

Happy Holidays!
I hope to see you at upcoming
meetings!

Michael

from our good friends at Smart Computing Computing
• Take A Shortcut In Excel:
If you use Excel frequently, you’re probably already familiar with many basic Excel keyboard
shortcuts. However, there are some little-known shortcuts that can help you work even more efficiently in
selecting ranges and moving around a worksheet. For example, you can quickly select an entire data region
(a range of data cells bordered by empty cells) by clicking one of the cells and then holding down CTRLSHIFT-* (asterisk). Another way to select a data range is to place your cell pointer in the range and then
press CTRL-A; press CTRL-A a second time to select the entire worksheet. You can also press CTRLcont’d on Page 11
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Word & Excel Tips - cont’d

you don’t have the Analysis ToolPak enabled.)
Excel displays the Data Analysis dialog box.
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The Data Analysis dialog box.

2. In the list of functions in the dialog box,
choose Random Number Generation.
3. Click on OK. Excel displays the Random
Number Generation dialog box.
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4. Using the controls in the dialog box, indicate
the parameters you want used in generating
a range of random numbers. (Make sure that
you specify a range of cells in the Output
Options area of the dialog box.)
5. Click on OK.
Copyright © 2010 by Sharon Parq Associates, Inc.
Reprinted by permission. Thousands of free Microsoft
Excel tips can be found online at http://excel.tips.net.
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More Portable Utilities for Your Flash Drive
by
Ira Wilsker

WEBSITES:
http://live.sunbeltsoftware.com
http://www.piriform.com/ccleaner/download/
portable
http://www.piriform.com/recuva/features/portableversion
http://www.piriform.com/defraggler/download/
portable
http://www.piriform.com/speccy/download/
portable
http://www.emsisoft.com/en/software/eek
http://iobit.com/toolbox.html
http://www.superantispyware.com/
portablescanner.html
http://www.liberkey.com
I continue to make extensive use of the
8GB flash drive that I carry on my keychain along
with my car keys. Just yesterday I was called to a
relative’s house to rescue a family computer that
had been devastated by malware, such that the
computer was nearly useless. Using the utilities
on my flash drive, I was able to remove some
stubborn malware, clean the hard drive, remove
useless items from the startup, defragment the
hard drive, and return the computer to good health.
My relative had complained that the computer had
previously been so sluggish that it took several
minutes to boot, then another three minutes just
for Internet Explorer to load, and that it took so
long for web pages to load that he gave up using
it. In less than an hour, using those portable
utilities, the computer ran like new; my relative
was pleasantly surprised when the computer
booted up in a few seconds. I asked him to time
how long it took for Internet Explorer to load after
the fix, and he was shocked to see IE load in about
two seconds! Without my flash drive loaded with
portable utilities, this would have been a much
more difficult and time consuming job.

Yesterday’s desperate call for help from
a relative was not an uncommon occurrence;
just Wednesday, four days ago, another relative
called in a panic saying that she had clicked on
an apparent legitimate website, and her computer
had been instantly hijacked by a type of malware
referred to as a rogue antivirus program “Security
Suite 2011”. This scumware would not allow
her to do anything on her computer until she
“activated” the extortion-ware by paying a
Russian cyber criminal $40 to clean her computer
of the hundreds of (false positive) viruses and
trojans that it found. Of course the program was
a scam which actively loaded other malware on
her computer, and took control of it for nefarious
purposes, such as sending out spam emails. This
malware took over her computer even though she
had a top-selling name brand security program on
her computer. Within an hour, I had sequentially
run three antimalware programs from my flash
drive, and her computer was cleaned of malware.
These two calls for urgent assistance are in-line
with the norm, as I get about three such calls in
a typical week. It would have been very difficult
for me to quickly clean these computers if it had
not been for the portable versions of popular free
software that I always carry with me on my flash
drive.
My 8GB flash drive attached to my
keychain has been getting a lot of use lately,
mostly on other people’s computers. I have
been steadily adding and updating software to
it, enhancing its potential. One of the recent
additions to my flash drive, which I used to
remove the malware on the two computers
discussed above, is the Sunbelt Software “Vipre
Rescue” program, a free portable malware
scanner and cleaner available for download from
live.sunbeltsoftware.com. Vipre Rescue is an
cont’d on Page 4
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More Portable Utilities - cont’d
81MB executable file which can be downloaded
to a flash drive, and then run to clean the target
computer. It is the latest updated version that
is available for download from the Sunbelt
website. When run, the executable will install
the software to a selected location, and then run
itself in a DOS (command prompt) window. By
default, Vipre Rescue will perform a deep scan,
looking for all malware, including the otherwise
difficult to detect rootkits that can often slip by
more conventional security software. While the
default is for Vipre to run a deep scan, which may
take a substantial amount of time to thoroughly
disinfect a computer, the user can manually
select other options from a command line such as
“VIPRERescueScanner.exe /quick” which will
perform a less thorough but faster quick scan.
Using the command line “VIPRERescueScanner.
exe /restore” will undo any repairs and restore any
quarantined items. Other command line switches
allow the user to specify paths to be scanned, and
display the logs of prior scans. While I prefer
the default deep scan, which is very good at
detecting deeply hidden malware, I often select
the quick scan from the command line, knowingly
sacrificing some potential detection for increased
speed. Since I routinely perform multiple scans
with different products, I feel reasonably confident
that I will detect and neutralize any malware on
the computer.
Some of the most frequently used
utilities on my flash drive are the freeware
portable versions of software published by
Piriform, including CCleaner (one of my alltime favorites), Recuva, Speccy, and Defraggler.
CCleaner (piriform.com/ccleaner/download/
portable), in its different versions and builds, is
likely the world’s most widely used hard drive
cleaning software, with over 500 million copies
downloaded! The portable version is intended
to be installed to a flash drive, where it can be
used to clean unnecessary and obsolete files from
a hard drive; it is precisely this portable version

that I used to clean the hard drives of the above
computers. CCleaner will do much more than just
clean the hard drive; it will also clean the registry
of obsolete data, uninstall unwanted programs,
clean the programs in the startup that load at boot
(a critical function in enhancing performance),
create or restore a system restore file, and securely
wipe deleted files. All of these functions are
appropriate to improve computer performance.
I frequently use the portable version of
Recuva (piriform.com/recuva/features/portableversion) to undelete files that had been accidently
deleted, or to recover files from discs that had
been accidently formatted. Recuva can also be
used to recover deleted emails, music files, videos,
images, word processing files, and other files that
had been deleted, provided that these files had
not been overwritten or wiped. While Recuva
offers a wizard to guide an inexperienced user in
the process to recover files, I choose to directly
recover them. Recuva can recover files from hard
drives, flash drives and other flash media, digital
cameras, MP3 players, and other devices.
The portable version of Defraggler
(piriform.com/defraggler/download/portable) can
defragment entire hard drives, or just selected
files. When a drive is fragmented, pieces of files
are written to widely separated places on the hard
drive, which reduces the ability of the hard drive
to quickly locate and utilize those files, making the
hard drive work hard and slow. Defraggler can
defragment the hard drive bringing these separated
file pieces together into one orderly file; it is
precisely this function that I used on the Internet
Explorer installed on the computer mentioned
above, which led to an almost instant loading of
IE after it was defragmented.
Many people are not aware of Speccy
(piriform.com/speccy/download/portable), but I
use it regularly from my flash drive to determine
the specifics of the hardware and software in
a computer. With this information I can find
updated drivers on the component manufacturer’s
cont’d on Page 11
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Dozens of Free Utilities from NirSoft
by
Ira Wilsker

WEBSITES;
http://www.nirsoft.net
http://www.nirsoft.net/about_nirsoft_freeware.html
http://www.nirsoft.net/false_positive_report.html
It is no secret to regular readers of my column that I am somewhat of a software junkie, often
very willing and eager to download and install interesting software. I am especially fond of free software
(freeware), and recognize the great contributions that the freeware authors have made to the computing
public. One of my favorite sources of freeware is a one-man software operation aptly named NirSoft, a
combination of the developer’s name, Nir Sofer, and the word “software”. While this is a part time oneman operation, Nir Sofer has developed over one hundred excellent programs and utilities that are well
written, enormously popular, lack any form of advertising pop-up or adware, and are totally free of charge.
I have been using several of the NirSoft utilities since my Windows 98 days, and always found
them efficient and useful. I have used some of the password recovery utilities, USB utilities, and several
others. According to the website, nirsoft.net, the most popular utilities are IPNetInfo, Volumouse,
MessenPass, and Protected Storage PassView.

IPNetInfo, available for download from nirsoft.net/utils/ipnetinfo.html, is designed to retrieve
information about IP addresses, those numerical sequences that identify a particular computer or server.
Typically in the format of 123.45.678.90, these IP (Internet Protocol) addresses point to a specific
computer or server location, and can be used to determine the likely source of an email, website, server,
or other internet connected appliance. The program is small and written in tight code, and requires no
additional installation or utilities in order to run it. Accord to Nir, “ IPNetInfo is a standalone program,
cont’d on Page 6
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Free Utilities from NirSoft - cont’d

cont’d from page 5

so it doesn’t require any installation process or additional DLLs. In order to start using it, simply copy
the executable file (ipnetinfo.exe) to any folder you like, and run it.” I copied the file to my desktop, and
use it mostly to determine the (mostly) true location of the sender of an email, or the (likely) real location
of a website or server; while this is not typically necessary for the casual user, I use it as a quick tool to
forensically locate the probable source of spam email and scam websites.

Many of us routinely watch TV or videos over the internet, and listen to a variety of audio.
Sometimes we need to adjust the volume in order to better hear the audio, and the standard Windows
volume controls are often inconvenient or located on an external speaker. Not all computers have a
volume control in the keyboard, so NirSoft provides a small utility that can control the volume by simply
using the wheel on the mouse. Most computer mice today are wheel mice, and not many people use the
wheel as a scroll tool as intended. By installing Volumouse (nirsoft.net/utils/volumouse.html), the user has
complete control over all of the audio volume of the system, utilizing only the wheel on the mouse along
with a function key, usually the “Alt” key. If the “Alt” key is pressed, the mouse wheel is a comprehensive
volume control, otherwise it functions normally as a scroll device. This has proven to be a very handy
utility to improve my enjoyment of computer audio and video.
cont’d on Page 7
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Free Utilities from NirSoft - cont’d

cont’d from page 6

Many of us use one or more instant messenger programs, such as Yahoo Instant Messenger,
AIM (AOL), MSN Messenger, Windows Live Messenger, and others. While I have a secure password
manager on my home desktop computer, and I use difficult to guess alphanumeric passwords, sometimes
I get confused or forget some of the many passwords I use while instant messaging. NirSoft has a utility
to help find instant messaging passwords, MessenPass. Available for download from nirsoft.net/utils/
mspass.html, MessenPass can find the passwords for all popular instant messaging programs, including
MSN Messenger, Windows Messenger, Windows Live Messenger, Yahoo Messenger, Google Talk, ICQ,
AOL Instant Messenger, AIM, AIM Pro, Trillian, Trillian Astra, Miranda, GAIM/Pidgin, MySpace IM,
PaltalkScene, and Digsby. It should be noted that this is not a hacker or cracker utility, as it can only
be used to “ ... recover the passwords for the current logged-on user on your local computer, and it only
works if you chose the remember your password in one of the above programs. You cannot use this utility
for grabbing the passwords of other users.” One warning is necessary for users of MessenPass is that
sometimes antivirus and other security programs occasionally report it as a virus of some type. This is a
false positive, as MessenPass is not a virus or Trojan, and this false positive is documented at nirsoft.net/
false_positive_report.html.
Protected Storage PassView is another small password utility that can display
“ ... the passwords stored on your computer by Internet Explorer, Outlook Express and MSN Explorer. The
passwords are revealed by reading the information from the Protected Storage.” Available for download
at nirsoft.net/utils/pspv.html, Protected Storage PassView can display the users’ registered passwords
for password protected websites accessed in Internet Explorer, Outlook and Outlook Express passwords,
auto-complete passwords in Internet Explorer, and MSN Explorer passwords. As with the other password
utilities, this is not a hacker program, as it can only display passwords of the current logged in user, and
cannot display the passwords of other users. Also as with the other password utilities, some security
software displays a false positive warning when the utility is opened; using a reputable third party utility,
virustotal.com, I have personally verified that these original utilities downloaded directly from the NirSoft
website were indeed clean of any malware, and that any such reports were indeed false positives.

cont’d on Page 10
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Word & Excel Tips from
Sharon Parq Associates
Inserting the Template Name in Your
Document

Every Word document has a template
attached to it. Depending on your version of Word,
this template defines things such as your menus,
toolbars, macros, and styles (among other things).
If you do not explicitly attach a template, then
Word uses the Normal template.
The name of the template file attached to your
document can be inserted into your document and
updated automatically. To do this, follow these
steps:
1. Position the insertion point where you want
the template file name to appear.
2. Display the Field dialog box. (In Word 2007
or Word 2010 display the Insert tab of the
ribbon and then choose Quick Parts | Fields
from the Text group. If you are using an
older version of Word, choose Field from
the Insert menu.)

The Field dialog box.
3. In the Categories list, choose Document
Information.
4. In the Field Names list choose Template.

5. Click on OK to close the dialog box and
insert your field.
Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by
permission. Thousands of free Microsoft Word tips can be found
online at http://word.tips.net.

Understanding and Creating Lists

There are two types of lists commonly used
in printed material. The first is a bulleted list,
and the second is a numbered list. A bulleted list
is a nothing but a list of individual items with a
symbol to the left side of the first line of each item
in the list. For example, the following is a bulleted
list:
• This is the first item in the list.
•

This is the second item in the list. There
is more than one line in this item. Notice
that the extra lines are aligned with the line
above, not with the bullet or the text margin.

•

This is the third item in the list.

•

This is the fourth item in the list.

In the case of this bulleted list, the symbol
used as the “bullet” is a small dot. A numbered
list is a little bit different. It consists of a series of
items, each with a sequential number in front of
it. Numbered lists are used extensively in “how
to” writing to describe a sequence of steps to be
followed.
This usage points out the primary way you
can decide which type of list to use. If you have
a sequence of steps, which must be followed in
order, then you should use a numbered list. If you
have a group of items to which you want special
treatment given, but they don’t represent a series
that must be followed in sequence, then you
should use a bulleted list.
Word allows you to quickly and easily create
lists. To do so, follow these steps:
1. Type your list, only pressing Enter at the
end of each item in the list. If an item runs
more than one line, do not press Enter at
the end of each line.
cont’d on Page 9

8
www.chpcug.org/

ChPCUG dues are $40 per year

THE PRINTER

December

2010

Word & Excel Tips - cont’d
2. Select all the items in the list.
3.

Click on the Bullets list tool to create the bulleted
list or the Numbering tool to create a numbered
list. (If you are using Word 2007 or Word 2010,
these tools are located on the Home tab of the
ribbon, in the Paragraph group. In older versions
of Word they are located on the Formatting
toolbar.)

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by
permission. Thousands of free Microsoft Word tips can be found
online at http://word.tips.net.

Using the CONCATENATE Worksheet
Function

Excel provides a function called
CONCATENATE which can be used to combine
the contents of several cells, or even to combine
cell contents with other text. For instance, let’s say
you wanted to add together the contents of cells
A3 and B3, separate them by a space, and have the
result appear in cell C3. All you need to do is put
the following formula in cell C3:
=CONCATENATE(A3,” “,B3)
Primarily, the CONCATENATE function
is used for compatibility with other spreadsheet
programs. You can just as easily use the
ampersand (&) operator to combine text values
using a formula. For instance, the following is
equivalent to the example of CONCATENATE
shown above:
=A3 & “ “ & B3

AutoFill with Random Numbers

Excel includes a feature that allows you to
automatically fill a range of cells with information
you have placed in just a few cells. For instance,
you could enter the value 1 in a cell, and then 2
in the cell just beneath it. If you then select the

cont’d from page 8

two cells and drag the small black handle at the
bottom right corner of the selection, you can fill
any number of cells with incrementing numbers.
This AutoFill feature sure beats having to type in
all the values!
You may wonder if there is a similar way to
use the AutoFill feature to place random numbers
in a range. Unfortunately, the AutoFill feature was
never meant for random numbers. Why? Because
AutoFill uses predictive calculations to determine
what to enter into a range of cells. For example,
if you entered 1 into one cell and 5 into the next,
highlighted the cells and then used AutoFill, the
next number entered in the cell below would be 9
because Excel can deduce that the increment is 4.
It is a constant increment that can be predicted.
Random numbers on the other hand are, well,
random. By nature they cannot be predicted, else
they wouldn’t be random. Therefore the predictive
nature of AutoFill cannot be applied to random
numbers.
However, there are ways around this. One is
to simply use the various formulas (using RAND
and RANDBETWEEN) to generate random
numbers. These formulas can quickly and easily
be copied over a range of cells, using a variety of
copying techniques.
Another approach is to use a feature of the
Analysis ToolPak which makes putting random
numbers into a range of cells pretty easy. Just
follow these steps:
1. Choose Data Analysis from the Tools menu.
If you are using Word 2007 or Word 2010,
you display the Data tab of the ribbon and
then click Data Analysis in the Analysis
group. (If you don’t see the Data Analysis
option on the Tools menu or, in Word 2007
or Word 2010, you don’t see the Analysis
group on the Data tab of the ribbon, it means that

cont’d on Page 2

9

THE PRINTER

December

2010

ChPCUG dues are $40 per year

www.chpcug.org/

Free Utilities from NirSoft - cont’d

cont’d from page 7

Password utilities are not the only utilities available from NirSoft, as many of the one hundred plus
utilities serve other functions. Some that I periodically use are the network utilities, some of which can
be used to determine the actual download speed of my internet connection, view computers attached to
the network, display details of wireless and Bluetooth networks in the area, and other network functions.
There are about a dozen free internet related utilities available, including cookie managers, cache viewers,
screen capture utilities, HTML converters, DNS utilities, and several other internet related utilities. Some
of the free desktop utilities include a file search utility, uninstaller, and file type manager. NirSoft has
about 10 free system tools, including a USB device manager (USBDeview, nirsoft.net/utils/usb_devices_
view.html, one of my most frequently used tools), a hardware device manager, driver manager, registry
scanner, and several other helpful tools. One of the system tools that I used a great deal with Windows
XP was BlueScreenView, which displayed the details of Windows crashes, making them easier to resolve.
NirSoft also has a selection of free tools to improve the functioning of the Outlook email program.
Other than the occasional false positive warnings from some security software, I have always found
that NirSoft’s free utilities can efficiently carry out their intended tasks with a minimum of effort. Nir
Sofer personally writes all of his software, and frequently posts updates and bug fixes, helping to insure
that the software is up to date. While NirSoft is only a part-time operation, and Nir Sofer does not directly
charge for any of his software, there is a link on the site for voluntary donations. For users that may
need some small, free, well written, specialized utilities, NirSoft would be a worthwhile source for that

10
www.chpcug.org/

ChPCUG dues are $40 per year

THE PRINTER

December

2010

from Smart Computing Computing - cont’d
Spacebar to select the column where your cell
pointer is located. Another helpful keyboard shortcut is to press END followed by an Up, Down,
Left, or Right arrow key to efficiently move the
cell pointer to the outermost edge of a data range.

• Skip A Bullet Or Number In Microsoft
Word:

There can be times when you’re working
with a bulleted or numbered list when you want
to add a new line without tacking on a number or
bullet. Perhaps you want to add a parenthetical
note below an entry without making it part of your
list. If you hold SHIFT and press ENTER, Word
will add a new line to your list without a bullet a
number. When you want to resume numbering or
bulleting, don’t hold the SHIFT key any longer.

cont’d from page 1

• Save The Page:

If you’re using Internet Explorer and you
come across a Web page with information you
want to preserve, there are two good ways to
keep the information without having to use a Web
browser to bring it back up. The first and simplest
way is to print it; it never hurts to have a hard
copy of information you need. Another method is
to save the Web page as an .MHT (Multipurpose
Internet Mail Extension) file, which is essentially
just a snapshot of the page. In this format you can
send the page to others or double-click on it to
open it directly. To make a .MHT file from a Web
page, click File (press the ALT key to reveal the
File menu if you don’t see it), click Save As, and
in the dialog box be sure to select the .MHT file
type. Tell the computer where to put the file and
click Save.

“Reprinted with permission from Smart Computing. Visit www.SmartComputing.com/groups to learn what
Smart Computing can do for you and your user group!”

More Portable Utilities - cont’d
website, where the latest drivers can be
downloaded for installation. Comprehensive
information is presented on the operating system,
motherboard, RAM, graphics card, hard drive,
and other components installed in the computer.
This information is often necessary to properly
configure, repair, or update components.
These utilities referenced above
accompany the additional utilities on my flash
drive, including those that I have written about
in the past. These additional utilities include
the portable versions of SuperAntispyware
(superantispyware.com/portablescanner.html),

cont’d from page 4

LiberKey (liberkey.com) which is a graphical
front end for over 300 other included portable
utilities, Emsisoft Emergency Kit (www.emsisoft.
com/en/software/eek) a powerful antimalware
program, and IObit Toolbox (iobit.com/toolbox.
html). With all of these utilities instantly available
to me from the convenience of my flash drive, I
am reasonably confidant that I can resolve a god
number of problems on most PCs that I encounter.
With the price of USB flash drives as low
as they are today, there is no valid reason why
users should not have these utilities available to
them just in case they are needed.
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The Next Regular Meeting will be at
The Severn River Middle School

Wednesday
December 8th, 2010
Meeting will be held in the large meeting room.
It starts at 7:00 P.M. with club business
and a short discussion period.

presentation on

Upgrading & Repairing
Your Computer
by

Fran Damratowski
Members and their friends are welcome to
come, ask questions and become enlightened.

1783 Forest Drive #285
Annapolis, MD 21401

How to Find: Severn River Middle School
SRMS is close to the Arnold, MD campus of the
Anne Arundel Community College. From Annapolis
and points south, take Rte 2 (Ritchie Highway) north
about 3 miles from the intersection of Rt. 50, turn right
on College Parkway. At the first light, turn left on
Peninsula Farm Road. (Of course, if you are coming
from points North, you would turn left onto College
Parkway) about a half-mile down the road the large
SRMS school building, set back off a large two level
parking lot, will be visible on your right. Park here
and go to the main entrance. Signs will be posted to
direct you to the Large Group Room where we will
be meeting.
How to find: The Technology SIG, A ChPCUG
Special Interest Group**
The meetings are held at the SRMS in the Library.
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